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Profound® Enhancements Bring Faster
Searching, New Content, and Much More

If you are a user of Profound for the Internet, you will now benefit from
accelerated search times, significant new company information, and

Table of Contents pricing on ResearchLine, BrokerLine and CountryLine.

Profound for the Internet, for those users more familiar with the Windows®-
based version, is now composed of two major database collections —
WorldSearch and QuickSearch — as well as Briefings. The eight databases
are listed below.

Profound WorldSearch Profound QuickSearch

ResearchLine Company Information

NewsLine Intellectual Property

BrokerLine Research & Development

CountryLine North American Newspapers

Both employ easy-to-use keyword search interfaces. 

Improved Search Time on WorldSearch

WorldSearch databases are now powered by a new
AltaVista® search engine resulting in a considerable
improvement in the search response times. This is
particularly valuable when conducting complex
searches and searches on Profound NewsLine 
(the largest WorldSearch database). 

A counter at the top of the screen indicates that a
search is in progress. The counter displays a cumula-
tive count of the number of records found, working
chronologically down through database segments
until the requested number of records has been
retrieved or the search is complete. 

New Company Information on QuickSearch

A number of new company data sources has been added to QuickSearch.
The new data will be of great interest if you require information on 
companies based outside the U.S., not available on QuickSearch until now. 

Continued on page 4

Figure 1: Profound Main Screen
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From the Editor
The April issue highlights new product
releases, enhancements to existing 
products, and content additions. Product
updates will be announced each quarter in
the Chronolog. Enhancements to Profound
on the Internet, changes to the Alerts 
feature in DialogSelect and the Dialog
Intranet Toolkit, and the introduction of
Dialog1, the new easy-to-use interface —
all are designed to make Dialog products

Dialog Bluesheets / DataStar Datasheets

DIALOG is a service mark of The Dialog Corporation registered with the U.S. Pat. & Trademark Office. Chronolog, DIALINDEX, DIALOG, DIALOG
OnDisc, DialogLink, DIALORDER, First Release, OneSearch, ONTAP, and Profound are trademarks registered with the U.S. Pat. & Trademark Office.
DataStar, DIALOG Headlines, DIALOG Homebase, DIALOGSelect, SourceOne, and SitePrints are service marks of The Dialog Corporation. All other
brand and product names are trademarks or registered trademarks of their respective holders. The contents of this publication are not 
copyrighted and may be freely reproduced.

meet the needs of all our users. In addition,
other changes to our products are high-
lighted, such as enhancements and addi-
tions to the DataStar collection, and pricing
changes, including academic pricing dis-
counts for selected OnDisc products. Also,
don’t miss the Search Solution for tips on
search techniques provided by subject
experts from the U.S. Knowledge Center.
This issue has something for everyone!  ◆

File 470 Books in Print®

File 500 Extel International Financial 
Cards from Primark

New or revised DataStar documentation is
available at: http://ds.datastarweb.com/
datasheets. Users can also consult the

®

1.800.334.2564 or 1.919.462.8600 

Fax: 1.919.468.9890

Please address any comments or 

questions to customer@dialog.com.

Trade Shows We wil l  see you there!

April 30 - May 2 Santa Clara, CA
Extranet/Intranet 2001 Conference &
Exhibition

May 5-9 San Francisco, CA
International Trademark Association

The Chronolog (ISSN 0163-3732) 
is published by:

The Dialog Corporation

11000 Regency Parkway, Suite 10

Cary, North Carolina 27511 USA.  

May 15-17 New York, NY
National Online Meeting 

May 29-31 Prague (Czech Republic)
INFORUM 2001 

This new or revised documentation 
is available in the Dialog Library at 
http:// library.dialog.com. Users can also
consult Dialog Bluesheets™ (File 415). 

DataStar file BASE—DataStar Database
Guides.

ADRD Adis R&D Insight

MCNF Mediconf: Medical Conferences 
and Events

IPUR IMSworld R&D Focus Drug 
Updates

PHAR Pharmaprojects

BIOL BIOSIS Previews®

KPEU/KPWO  Kompass: Europe, 
Kompass Middle East, Africa, 
Asia-Pacific, Americas
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Dialog1: The Power of Dialog Made Simple

Dialog1 is a suite of powerful and
simple to use search forms that

allows users to obtain relevant data from
Dialog with just “one click” of the mouse.
Anyone can use it. An attorney searching
for a Japanese patent number, a scientist
looking for drug data from a clinical trial,
a business consultant checking on a 
competitor’s most recent acquisition, 
or anyone else who needs authoritative
information to perform his or her job can
find the answer on Dialog1. Information 
professionals and their clients within their
organizations will welcome Dialog’s
newest solution to their information needs. 

How Does It Work?

Developed with the help of librarians and
information professionals, Dialog1 deploys
powerful Dialog searches “behind the
scenes.” Expert Dialog searchers have
constructed these strategies based on 
the questions most frequently asked of
Dialog Knowledge Center experts. There
is no charge to access Dialog1, and most

of the searches provide free title lists.
Customers only pay for the information
they download. There are no DialUnits or
connect time fees. Dialog1 is available at
http://www.dialog1.com with your Dialog
user number and password.

Content Modules

Divided into research modules, Dialog1
uses a simple and intuitive “question and
answer” format to connect customers to
their answers, so their time can be spent
working with information and not work-
ing to find the infor-
mation. The modules
that are currently
available include
Intellectual Property,
Pharmaceuticals,
Business Intelligence,
World News, and
Marketing. [See
Figure 1 below]

• The Intellectual
Property module
gives customers
easy access to full-
text patents, patent
families, patent
citations, global trademarks, and U.S.
copyrights. This module also provides
the intellectual property researcher with

some useful features
unique to the 
industry, such as 
a Japanese patent
finder. With Dialog1,
patent searchers do
not have to worry
about Toroku,
Kokoku, Kokai,
Utility Models,
Showa Era, or
Heisei Era patents.
Dialog1 will find 
all of the possible
permutations of a

Japanese patent number and provide a
list of patent titles by searching across
the Derwent World Patents Index,
INPADOC, and JAPIO databases.

• The Pharmaceutical module enables
customers to access patent information,
industry news, research news, product

pipelines, company profiles, research
literature, and regulatory information.
By using the Pharmaceutical module,
users can follow the products that their
competitors are developing and where
those products are in the development
cycle. For example, if a chemist wanted

to track the products being developed
by Eli Lilly but only in the earliest
phases (pre-registration and pre-clinical),
Dialog1 enables him or her to conduct
this search. An “Advanced” search can
be performed just by entering a drug
name. Dialog1 does the search using
Dialog’s powerful indexing and unique
search features to obtain results which
are then sorted by date with duplicate
records removed. See the example
search form in Figure 2.

• The World News module, divided into
geographic areas, provides access to
news sources throughout the world. For
example, just by clicking Japan on the
world map, users are linked to the Asia,
Pacific Rim, and Australia search form.
Content is drawn from leading news
sources like Agence France-Presse, 

Figure 1: Main Screen of Dialog1

Figure 2: Pharmaceutical Search Form

To find clinical research literature on Zyprexa, just
place the drug name in the “drug name” field and
click the search button. As always, you can search

on generic names and lab codes as well.

Continued on page 6

What’s New
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Profound Enhancements — Continued from page 1

New databases include: 

• D&B—Dun’s Market Identifiers®

contains directory listings, sales volume,
and marketing data for over 18 million
establishments in nearly 200 countries
worldwide. D&B Canadian Dun’s
Market Identifiers is also newly offered
whilst Market Identifiers for the U.S.
has been available previously. 

• Teikoku Databank (Japan) provides the
latest information on approximately
240,000 Japanese companies. Full and
condensed Balance Sheets and Income
Statements are available for about
130,000 companies.

• ICC British Company Financial
Datasheets (U.K.) provides analysis on
the latest financial data of all companies
with limited liability in the U.K.,
including “large,” “medium,” and
“small,” quoted and non-quoted public
and private companies from all sectors
of U.K. industry and commerce.

• Kompass comprises a range of databases
providing information on numerous
companies in all regions outside the
U.S. Kompass has an emphasis on
manufacturing, industrial, and associated
service sectors with product names 
displayable and searchable. The Thomas
Register Online®, giving similar cover-
age for companies in North America, 
is already available on QuickSearch.

• Investext® includes the full series of
Investext PDF reports for the first time
on QuickSearch. Investext analyst reports
cover financial forecasts, market share,
competitive analysis, industry trends,
and more.

In addition, the EdgarPlus™ database
from Disclosure will now be available 
on QuickSearch with Extel from Primark
coming in the future. 

Company information on QuickSearch has
been rearranged with the introduction of
new data and the division of existing
U.S. data into new sets. Note there is no
change to menus for the other three data-

base 
collections on
QuickSearch
(Intellectual
Property, R&D,
North American
Newspapers). For
more information
about company
information on
QuickSearch, see
the online version
of the April Chronolog at
http://library.dialog.com/ chron. 

Removal of CompanyLine and
WireLine From WorldSearch

With the additional company-related
information that has been added to
QuickSearch, CompanyLine has been
removed. This is intended to avoid
unnecessary duplication of data bringing
greater focus to company-related infor-
mation on Profound.

In the same way WireLine — the
WorldSearch database providing news
reported on over twenty-five news wires
— has also been removed from
WorldSearch. All the news wire sources
are now being loaded onto Profound
NewsLine, the main WorldSearch news
database, 
meaning you can search all news sources
(wires and published) simultaneously.

Section Prices Viewable in Table of
Contents on Profound for the Internet 

In response to requests from customers,
Profound for the Internet now presents a
price alongside each separately available
section of a report, giving you better 
control of your spending. [See Figure 2.]
This applies to reports in ResearchLine,
BrokerLine, and CountryLine.
(NewsLine reports do not have Tables of
Contents). This feature will be particular-
ly valuable if you are an information pro-
fessional because it enables you to pro-
vide accurate cost estimates in advance
for work you undertake for your clients

or colleagues. 

Moving to Profound for the Internet 

The new enhancements outlined above
have removed many of the key obstacles
identified by users of Profound for
Windows® for not migrating to the
Internet-based version of the product. 
For example, with the AltaVista® search
engine, Profound for the Internet now
matches the Windows-based product for
search speed. Similarly, Table of Contents
pricing for sections of reports—long
regarded as a great strength of the
Windows-based product—is now 
available on Profound for the Internet.

Your user name and password are valid
on both versions of the Profound product.
So be sure to test the latest enhancements
at http://www.profound.com or

Figure 2: Table of Contents with Prices Listed

Office Address Changes
The Chicago office of Dialog has moved
to a new location:

Dialog Corporation
180 North LaSalle, Suite 2930
Chicago, IL 60601
Main Number: 312-726-9206
Fax Number: 312-726-3550

Dialog Sweden has changed its location
to central Stockholm:

The Dialog Corporation Sweden AB
PO Box 6430
SE-113 82 Stockholm
SWEDEN
Phone: +46 (0)8 587 671 30
Fax: +46 (0)8 587 671 92  ◆

What’s New
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Dialog will release enhancements to the Alerts function on
DialogSelect™ and Dialog Intranet Toolkit that will enable

users to have more specialized delivery of their Alerts at no
extra charge. This release offers enhancements for both domain
access users (those users who are accessing Dialog through one
user number in an organization) and regular Alert users in two
main areas: (1) delivering Alerts and (2) managing Alerts.

Delivering Alerts

In the past when using DialogSelect and Intranet Toolkit, a 
single email address was the only address option for delivery of
all alerts for a user number. This was a particular problem for
domain access accounts where there is a single user number for
the entire organization. With the new release, users can now set
up Alerts and have the results delivered to email destinations of
their own choosing — either theirs or alternate addresses. The
result is a more direct delivery of the latest information.

Here’s how it works. When you create a new Alert, a drop down
list of email addresses stored under your user number displays.
Simply enter a name for the Alert and select the email address
for delivery (See Figure 1). 

To set up a new email address, click CREATE NEW ADDRESS.
For domain users, the “Email Address” is a blank input box,
unless the user has created an Alert or managed Alerts previous-
ly during the session. When CREATE ALERT is clicked, the 
system checks to see if the email address has been used before.
If not, you are prompted for information, such as email software
and name (See Figure 2).

Managing Alerts

Another new enhancement lets customers manage the Alerts
stored under the different email addresses and easily make
changes to the email address profiles. 

For domain customers, this means that individual users can
manage their Alerts by signing in with their email address via
the “Manage Alerts” link on the Help page. In addition, account
administrators can control all Alerts through a password-
protected Alerts administrator site. From the regular Alerts 
sign in page, the administrator just clicks the link to display the
Administrator Sign In page. After signing in, all email addresses
for the user number are listed on the new “Manage Alerts: All
Email Addresses” page (See Figure 3).

Regular customers just click the “Manage Alerts” link on the
Help page to display the “Manage Alerts: All Email Addresses”
page, which lists all email addresses for that user number.

Using these two new enhancements to the Alerts function on
DialogSelect and Dialog Intranet Toolkit allows you to set up,
modify, and delete Alerts quickly and easily. You now have the
flexibility on one Dialog user number to set up and send Alerts
to any and all addresses you wish. Don’t delay — set up your
Alerts today. 

For more information about setting up Alerts, please contact
your local Help Desk: Knowledge Center (U.S.) at 1-800-3-
DIALOG (1-800-334-3564) or U.K. at 44-171-930-6900. A
workbook entitled Creating and Using Alerts, which demon-
strates how to set up Alerts, is available at the Training Center
web site at: http://training.dialog.com/sem_info/courses.  ◆

Enhancements to Alerts on DialogSelect™ and Dialog Intranet Toolkit

What’s New

Figure 1

Figure 2

Figure 3
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Books In Print® on Dialog: Reloaded and Current

As of March 2001, Books In Print
(File 470) on Dialog is current and

has returned to monthly updates with the
February 2001 update. There are now
almost 3 million records in the file with
details of print status, bibliographic infor-
mation, publisher data, and awards granted
to each title. Also, with the reload of the
file, the Dialog MAP feature is once again
working with File 450: Publishers, Distri-
butors, and Wholesalers. Both databases
are produced by R.R. Bowker, a division
of Reed Elsevier Inc. Use RN to MAP
the Bowker Publisher Identification
Number in either file.

The Books In Print database is a major
source of information for all books pub-
lished or distributed in the United States
that are available to the general public or
trade for single or multiple copy purchase.
The database includes scholarly, popular,
technical, law, medical, adult, juvenile,
reprint, and all other types of books 
covering all subjects. Records typically
include title, author, ISBN, status, series
name (if any), publisher, pagination,
binding, intellectual and grade level, 
and hard copy source. Records may also
include multiple ISBN entries for books
that are published in multiple formats.
Extensive subject classification is also

provided through Bowker Subject
Headings and other descriptor lists. 

With the reload, there is a new field to
indicate Awards (AW=) presented to the
book, including Newbery, Caldecott, and
Pulitzer awards. EXPAND the AW=
index to see the full scope of the awards. 

MAP

Use Books in Print (Dialog File 470) to
track down the publisher of a book. Then
use the MAP feature to search File 450 to
find publisher information, to get their
toll-free number, and to check what dis-
count schedules they may offer. File 450
is a directory database of the entire U.S.
book and electronic publishing industry.
It provides company and contact details
of publishers’ imprints and subsidiaries
and divisions, as well as details of whole-
salers and distributors of their titles. The
file contains address and ordering infor-
mation, including discount scheduling.
You may also begin your search in File
450 if you know the publisher name 
and wish to find a list of titles for that
publisher in File 470. To view a sample
search using the MAP command, see the
online version of the April Chronolog at
http://library.dialog.com/chron.

ALERTS

Alerts for File 470, Books In Print, will
begin running again with the February
2001 update. If you wish to view records
in your search query that have been
added to the database during the year
2000 (which covers most of the time the
database was not updating), you may use
the RS= index (Date of record in file).
Use SELECT RS=2000? to retrieve all
records added to the file during the year
2000. There are 344,800 records that are
retrieved with this RS search. Please be
sure to EXECUTE your Alert and then
AND your final set with RS=2000?. To
view a search example on how to retrieve
records added to File 470 in the year
2000, see the online version of the April
Chronolog at http://library.dialog.com/chron.

For more information on either File 470
or File 450, contact R.R. Bowker at 
800-323-3288 or 908-464-6800. A
revised Bluesheet for File 470 is included
with the April Chronolog. Please anno-
tate your Bluesheet for File 450 to reflect
that the MAP code is now RN instead of
PU. You may also find both corrected
bluesheets in Dialog Bluesheets™

(File 415) and on the Dialog website
(http://library.dialog.com/bluesheets/).  ◆

Content Update

AP News, Asia Pacific News, World
Reporter, Xinhua News, and more.

• The Business Intelligence module
allows customers to access company
profiles, financial information, market
share, investment research, joint ven-
tures, and industry trends, to name a
few. It is divided into four sections:
company, product, industry, and finan-
cial information. The remote link service
to PDF reports from Investext is also
available in Dialog1, giving users
access to this leading investment
research source.

• The Marketing module takes advan-
tage of Dialog’s marketing-specific
content, such as trade publications like
Advertising Age, Adweek, and
Brandweek. It then couples this slice 
of content with business and industry
information creating a unique solution
for marketing professionals.

More modules are coming soon, such as
Energy, Biotechnology, and Engineering.

Additional Features

• Buttons for “Cost” and “Search Again”
enable the user to view the cost of

records or edit a search strategy.
• The “Sources” button, located at the

top of the navigation bar throughout 
the product, provides access to Search
Forms, Databases Used during a
search, and Search Limiters, the
“behind the scenes” strategy.

• “Alert Request” gives the searcher
access to Alerts set-up help.

Dialog1 offers high-level content with 
an easy-to-use interface. If you have a
Dialog account, you can begin using
Dialog1 today. If not, please contact 
dialog1_help@dialog.com or visit our
web site at www.dialog1.com.  ◆

Dialog1 — Continued from page 3
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Reuters Business Insight Reports Launched on DataStar 

Business Insight Reports (RBIR 
on DataStar/File 759 on Dialog), 

produced by Reuters Business Insight, a
world-leading information provider, was
launched on DataStar in March 2001.
RBIR provides detailed, up-to-date 
analysis and forecasts for the following
seven key growth areas:
• Ecommerce • Healthcare
• Consumer goods • Technology
• Energy • Human resources
• Financial services

The database will be updated monthly
and coverage is global. The connect per
hour charge is CHF87.00 / US$60.00 and
CHF27.60 / US$19.04 per text paragraph.

Search Features

Reports can be purchased by the section. To view the Table of Contents, use the print
command: ..P TI TC 1. Each section displays, along with the corresponding paragraph.

Title: B2B on the Internet: 2000-2005:THE BUSINESS PROCESSES.
TC 4.0 THE BUSINESS PROCESSES TX (1)

4.1 THE THREE CORE BUSINESS PROCESSES TX (2)
4.2 DYNAMICWEB ENTERPRISES TX (3)
4.3 ST.PAUL SOFTWARE  TX (4)
4.4 SELECTED DISTRIBUTION MANAGEMENT PROFILES TX (5)
Selected online procurement providers TX (6).

To view the required section, use the command: ..P TX(2) 1.

The complete database search guide is available in BASE; search BASE-RBIR. 
The online datasheet can be found at http://ds.datastarweb.com/datasheets.  ◆

In the Spotlight
SPORTDiscus Highlights Health and Wellness for the Office and at Home

If you have always thought of
SPORTDiscus as a database for the

sports-minded only, you are in for a
pleasant surprise. Dialog File 48 and
DataStar file SPOR provide articles related
to stress, mental training, fitness, goal
setting, visualization, coaching, training,
and nutrition, all familiar terms in the
business environment. The subjects listed
are not restricted to the world of sport.
On the contrary, all of these areas are
being used as research benchmarks in
corporate wellness and healthy lifestyles.

This bibliographic database with over
500,000 references is easily searchable;
and all of the references from book 
chapters, journals, and periodicals are
pre-qualified by the Sport Information
Resource Centre (SIRC) indexing adviso-
ry board. Each reference is given a
research level: B = Basic; I =
Intermediate; and A = Advanced. With
indexing partners from the United States,

the United Kingdom, France, Spain,
Australia, Sweden, China and Israel to
name a few, this database of fitness, med-
icine, and training is truly a global
resource.

In addition, the fulltext of over 75% of
the SPORTDiscus references is available
from Dialog through DialOrder®. 

Content Coverage

SPORTDiscus provides full coverage of
many topics, such as psychology and
mental training, employee fitness programs,
and nutrition and ergogenic aids. These
complement information obtained from
other databases on Dialog and DataStar,
such as MEDLINE®, ERIC, PsychINFO®,
EMBASE®, and ABI/INFORM®. The fol-
lowing table shows the number of
records in SPORTDiscus on these sub-
jects.

Number of Records
Psychology/Mental Training 8,436

Employee Fitness Programs 1,459 
Nutrition and Ergogenic Aids 12,511

Whether you are directing a business
information resource center, working as a
human resources professional, or admin-
istering an employee assistance program,
the breadth of references will offer hubs
of knowledge that can be used in research.

Thesaurus Available

Finally, users of SPORTDiscus will have
the benefit of the SIRCThesaurus when
using the database. Its hierarchical and
extensive cross-reference structure, with
an estimated 12,000 descriptors, has
made this thesaurus the industry standard
used by all of our indexing partners
around the world.

For more information about SPORTDiscus,
please refer to the Bluesheet for Dialog
File 48 (http://library.dialog.com/bluesheets)
or the Datasheet for DataStar, File SPOR
(http://ds.datastarweb.com/datasheets/). ◆

Content Update
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MEDLINE® Update

At the time of writing, the first updates
for MEDLINE (F155/154/MEDL)

have been received and are being
processed. The reload of MEDLINE
(2001 version) is also in progress. 

With the resumption of updating and
going forward, all MEDLINE updates
will contain In-Process records (formerly
known as PreMEDLINE). In-Process

New Pricing Structure for Pharmaprojects 

In 1999, Pharmaprojects saw the intro-
duction of a host of additional features,

which included the origin of material,
indication, and route of administration.
During 2000, Pharmaprojects focused 
on improving the timeliness of the data. 

Following these enhancements and some
detailed analysis of the drug pipeline infor-
mation market, the decision was taken to
realign the pricing structure with other
R&D database providers and to return to
a subscriber/non-subscriber model. Sub-
scribers are defined as Dialog or DataStar
customers who buy Pharmaprojects at
their site directly from PJB Publications
in either hardcopy or electronic form.

Pricing Changes

From April 1, 2001, the following pricing
structure applies to Dialog and DataStar:
– Price per record for non-subscribers

$12/SFr 17.40
– Price per record for subscribers

$6.30/SFr 9.13 

Dialog DialUnits have dropped for both
subscribers and non-subscribers from
$24.60 to $24. Connect hour prices remain
unchanged at SFr 4.62 for DataStar. 

Pharmaprojects users who hold Alerts on
Dialog and DataStar and are non-subscribers
should be aware that the price per record

has also risen to $12/SFr 17.40. Rates for
subscribers are at $6.30/SFr 9.13. Alert
profile prices on both systems remain
unchanged. 

The changes have been communicated to
customers through online banners and help
messages and by letter to non-subscribers. 

Password Coding on Dialog

Dialog and PJB Publications have worked
together over the last few weeks to ensure
that all users of Pharmaprojects are 
correctly coded as subscribers or non-
subscribers. 

File 128 is the non-subscriber file; File
928 is the subscriber file. If access is
denied when you enter 928 (“928 is
unauthorized”), your USERID has not been
coded for subscription status. If you know
that you are not a subscriber, switch to
File 128. 

IMPORTANT: If you are a subscriber,
you must use File 928 to benefit from the
discounted rate. If you use File 128, you
will be charged at the higher, non-
subscriber rate.

Password Coding on DataStar

The file labels for subscribers and non-
subscribers remain PHAR, PHDI, and
PHLP. However, when you access these

files as a non-subscriber, the following
message appears on your screen:

Your Userid is not validated for the  
PHAR/PHDI/PHLP subscription rate. 
Type ..PRICE to check current prices. 

If you are a non-subscriber, accept the
message and carry on searching. You will
be charged at the non-subscriber rate.  

If you  think you should be coded as a
subscriber, contact your nearest Dialog 
or DataStar Customer Services Desk or
Hayley Spendlove from RJB (Hayley.
Spendlove@pjbpubs.com) at +44 (0) 20
8332-8820 and ask them to check your
status. 

Editorial Enhancements Coming

Pharmaprojects and Dialog will shortly
be announcing details of editorial
enhancements for 2001. These will
include: 
• Comprehensive information on 

indication and status for each drug
• An alerting service which highlights

updates to data
• Coverage of 12 additional countries

Watch for more information in an 
upcoming issue of the Chronolog.  ◆

Content Update

records are added to the database by the
National Library of Medicine (NLM) and
do not carry indexing terms in order to
speed up the entry of records into the
database. Once indexed by NLM with
Medical Subject Headings (MeSH) and
other indexing terms, In-Process records
will be replaced in the database by the
definitive version. 

We expect to provide customers with 
a search mechanism for identifying 

In-Process records in MEDLINE. Further
information on this search feature will be
posted in HELP NEWS 155 for Dialog
and BASE for DataStar as soon as it is
available. 

If you have any questions regarding the
changes to the NLM databases, please
contact your nearest Customer Services
Helpdesk and watch for banner messages
and future MEDLINE updates in the
Chronolog.  ◆
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RAPRA OnDisc Now Released 

Kompass Product Classifications on DataStar
Now Searchable in Five Languages 

Two main Kompass files on DataStar
allow for multi-country searching:

KPEU includes the European countries
and KPWO, the Middle East, Africa,
Asia-Pacific and Americas. Now, KPEU
and KPWO each have four sub-files 
within which the Product Classification
paragraph (CC) can be searched and 
displayed in each of five languages.
There are ten Kompass files in all.

For European countries, sub-files for
product classifications are
KPEU - English KPEI - Italian
KPEF - French KPES - Spanish
KPEG - German

For Middle East, Africa, Asia-Pacific and
Americas, sub-files for product classifica-
tions are
KPWO - English KPWS - Spanish
KPWF - French KPWI - Italian
KPWG - German

The connect per hour charge is SFr87.00
/ US$60.00 and SFr4.86 / US$3.35 per
full record. 

The complete database search guide is
available in BASE. Search BASE-KPEU
or BASE-KPWO. The online datasheet 
is available at http://ds.datastarweb.com/
datasheets.  ◆

The RAPRA: Rubber & Plastics data-
base comprises a large collection of

carefully produced, extensively indexed
summaries of published literature covering
a wide scope of subjects encompassing
technical, academic, commercial, and
marketing aspects of the rubber and plas-
tic industries. Source materials include
over 500 journals, together with confer-
ence papers, patents, specifications and
standards, books, reports, press releases,

company literature, data sheets and direc-
tories. Coverage is fully international
with source material in a wide range of
languages from 30 different countries,
including North America, Australia,
Europe, Japan, and China. 

Six updates per year are available. A 15%
academic discount applies. For further
information, see http://products.dialog.
com/products/oddatas/rapra.html.  ◆

Content Update

Special Academic Discounts
for Selected OnDisc Products
• World Surface Coatings Abstracts™ is a

specialist product that will be of interest
to academics, such as technical libraries
of universities, who are involved in any
kind of coatings research, including
paints and adhesives. A new 40% 
discount for academic customers 
will make WSCA more affordable to 
university libraries. See http://products.
dialog.com/products/oddatas/wsca.html
for full product details.

• A new backfile for 1999 has been 
created for all four newspaper products:
Detroit Free Press; Miami Herald;
Philadelphia Inquirer, and the Los
Angeles Times. A 40% discount for 
academic customers applies. See
http://products.dialog.com/products/
oddatas/npapers.html for further details. ◆

DataStar Happy Hour on Foodline®: Current Food Legislation

On May 17 and 18, 2001, DataStar and
Leatherhead Food are offering a Happy
Hour on the Foodline®: Current Food
Legislation database (File label: FOLE). 

FOLE is a unique and authoritative source
of food additive, composition and label-
ing legislation. References to standards 

provide detailed information on the 
composition and labeling requirements 
of foods in seven EU countries, the USA,
and Canada.

On May 17 and 18, connect time will be
free, and you can download up to five
records free of charge. If you print out

more than five records, you will be
charged at the discount rate of $15/SFr
21.75 per record that currently applies to
this file until the end of August 2001 only. 

Take advantage of this free offer to get to
know Foodline: Current Food Legislation. 

Files Removed 
• The Omaha World-Herald (File 683)

has been removed from Dialog. 
Please discard the Bluesheet. 

• Cable, Satellite & TV News (CSTN) has
been removed from DataStar. For alter-
native databases, try BIDB (Business &
Industry™), PTSP (Gale Group Promt),
and INFO (ABI/INFORM®).  ◆

◆
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Search Solution
Converting Embedded Tables into Excel

There are many records in Dialog databases that contain 
statistical data in the form of tables. One database that 

contains a number of tables is File 93, TableBase. It is often
useful to place a table from a Dialog record into a report that
you are creating; thus, it is important to be able to convert the
data from a Dialog database into a spreadsheet, such as Excel.
The following example illustrates this function.

If your search yields a record, which contains an embedded
table that you would like to convert to Excel, just follow the
steps below which converts the table from the Dialog Record
shown in Figure 1 to a spreadsheet.

?b 93

File 93:TableBase(R) Sep 1997-2000/Apr W2
(c) 2000 Resp. DB Svcs.

Set Items Description
--- ----- -----------

?s ((cat or cats) and bird? and reptile? and dog?)/ti
31 CAT/TI
4 CATS/TI
5 BIRD?/TI
1 REPTILE?/TI

29 DOG?/TI
S1 1 ((CAT OR CATS) AND BIRD? AND 

REPTILE? AND DOG?)/TI

?t s1/9

1/9/1
DIALOG(R)File 93:TableBase(R) Sep
(c) 2000 Resp. DB Svcs. All rts. reserv.

01042932 SUPPLIER NUMBER: 02278073
US survey of pet owners finds percentage that own 
anywhere from zero to five or more dogs, cats, 
birds, reptiles, “pocket pets” or ferrets in 1999

HOW MANY PETS PET OWNERS OWN

0 1 2 3 4 5 or more
Dog 3% 51% 28% 10% 4% 5%
Cat 9% 35% 26% 11% 8% 11%
Bird 51% 25% 11% 3% 4% 6%
Reptile 77% 13% 4% 1% 2% 4%
Pocket pet(*) 76% 11% 5% 2% 2% 4%
Ferret 84% 6% 6% 1% 1% 1%
Other 44% 23% 8% 3% 3% 20%

(*) Includes hamsters, guinea pigs, gerbils and 
other small mammals
Not all rows add up to 100%, due to rounding.
Source: American Animal Hospital Association

SOURCE: American Animal Hospital Association

. . .

Step 1: Highlight the table of interest from the beginning of the
table to the end, including any footnotes you want to include on
your spreadsheet (See Figure 2).

From the Edit menu,
select Copy. 

From the File menu,
select Save Copy as;
then Save Selection
as…

Choose to save the file
as a text file in the
Save file as type: box
by selecting Text Files
(*.TXT). Enter the
name of the file in the
File name box; then
click the OK button.

Note: If you are using one of the web products, DialogWeb or
DialogClassic, you will need to use your browser functions to
copy the table and then use a word or text processor to save the
file as a text file. To use Microsoft Word to do this, use the 
following steps:

1. Open Word.

2. From the File menu, select New. Select Blank Document
from the General Category.

3. In the new document, use the Edit menu and select Paste.

4. From the File menu, select Save As. Choose to save the file
as a text file in the Save as type: box by selecting Text Only
(*txt). Enter the name of the file; then click the Save button.
You will be asked if you really want to save; click Yes.
Close this document.

Step 2: Open Microsoft® Excel.

From the File menu, choose Open; then select the appropriate
directory in the Look in: box. You will not see your text file
until you change the Files of type: box to show Text Files
(*.prn; *.txt; *.csv).

Step 3: Choose your file and click Open. You will be in the
Text Import Wizard. Follow the instructions for the Wizard.

Make sure
that the
Original
Data Type is
set to Fixed
width; then
click Next>
(See Figure 3).

Continued on page 11

Training Update

Figure 1

Figure 2

Figure 3
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Follow the
instructions
on the screen
to place your
column breaks
in the appro-
priate loca-
tion. You may
want to scroll
down to make
sure that

everything is lined up correctly. Ignore the text footnotes; they
will be cleaned up later. Click <Next> (See Figure 4).

Choose the
appropriate
data type for
each column
by clicking
the column;
while the col-
umn is select-
ed, click one
of the radio
buttons for

General, Text, Date, or Do Not Import Column (See Figure 5).
The heading of each column will change to reflect your choice. 

Important Note: If a column contains numbers and you are
NOT going to be using the numbers to perform calculations,
such as zip codes, select the data type of Text. Otherwise, the
values can be converted so that a number such as 02714
becomes 2174.

Then click Finish.

Step 4: Widen the columns to the appropriate width, and edit the
title and footnotes so that all information is in one cell per row.
Then, add any other formatting desired. Finally, SAVE your file
as an Excel workbook instead of a Text file when you are finished
(See Figure 6).

Take advantage of the concise tables available in Dialog 
databases. You can now easily embed them in any report or
presentation you are creating.  ◆

Keeping Current with Dialog Alerts

Keeping up-to-date is a major 
competitive advantage in today’s

fast-paced technological workplace. The
Dialog Alerts service lets you store a
search and have it run automatically when
a database is updated. The stored search
is run against the new items in the data-
base, and the results are sent to you imme-
diately by e-mail, fax, or postal mail.
Each of Dialog’s products — DialogWeb,
Dialog Classic, DialogClassicWeb,
DialogSelect, Profound, DataStar, and
Dialog1 — enables users to create their
own Alerts.

For your convenience, all of the Dialog
seminars, online courses, and applications
briefings provide an application illustrating
how to create Alerts in specific subject
areas. In addition, a two-hour briefing,
entitled Creating and Using Alerts, focuses
specifically on creating Alerts using
DialogWeb, Dialog Classic, Profound,
and DataStar. Check the training schedule
for classes held in your area. The work-
book is also available online in the
Training Center at http://training.dialog.
com/sem_info/courses. Use the Dialog
training materials as models and set up
your own Alerts.  ◆

Training Update

New Update Schedule for
Harvard Business Review
Harvard Business Review has informed
us that they will be increasing the update
frequency for File 122/HBRO. Beginning
in January 2001, the file will update 10
times per year. The file will update
monthly with the exception of two months,
which will be combined. The December/
January 2002 update will contain articles
spanning both months, as with the com-
bined issue for July/August.

Harvard Business Review provides a
complete range of strategic management
subjects of interest to professional man-
agers or researchers, including accounting,
automation, business ethics, industry
analysis, strategic planning, and trade.  ◆

Figure 4

Figure 5

Figure 6
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Training Schedule
Training classes on Dialog are held
throughout the world. For the most current
schedule for all locations, check the
DialogWeb site at http://training.dialog.com/.
To register, U.S. clients should call the
Knowledge Center at 1-800-3DIALOG
(800-334-2564).

Northeast 
Boston, MA
4/23 Chemical Information Seminar
4/25 Developing Patent Research Expertise,

Pt. 3: Prior Art
4/25 Developing Patent Research Expertise,

Pt. 4: Competitive Intelligence
4/26 Developing Dialog Searching Expertise,

Pts. 1 & 2: Fast Start and Intermediate
4/26 Intellectual Property: Trademarks &

Copyright
4/30 Engineering Information & Techniques
5/3 Company Intelligence
5/3 Market Intelligence
5/7 Dialog Application Briefing:

Environmental Issues
5/9 Biomedical Information Seminar
5/10 Developing Dialog Searching Expertise,

Pt. 3: Advanced
5/10 Developing Dialog Searching Expertise,

Pt. 4: Power Searching
5/14 Fundraising with Dialog
5/16 Dialog Application Briefing: Aerospace

& Defense
5/16 Developing Dialog Searching Expertise,

Pts. 1 & 2: Fast Start and Intermediate
5/17 Pharmaceutical Science Searching
5/17 Pharmaceutical Business Searching
5/21 Chemistry for Non-Chemists
5/23 Developing Patent Research Expertise,

Pt. 1: Patent Search Basics
5/23 Developing Patent Research Expertise,

Pt. 2: Patent Families & Legal Status
5/24 Developing Patent Research Expertise,

Pt. 3: Prior Art
5/23 Developing Patent Research Expertise,

Pt. 4: Competitive Intelligence
5/30 Intellectual Property: Trademarks &

Copyright

Midwest
Chicago, IL
4/24 Developing Patent Research Expertise,

Pt. 3: Prior Art 
4/24 Developing Patent Research Expertise,

Pt. 4: Competitive Intelligence
5/8 Developing Dialog Searching Expertise,

Pts. 1 & 2: Fast Start and Intermediate
5/10 Biomedical Information Seminar
5/22 Asia-Pacific Corporate Intelligence

St. Paul, MN
4/25 Intellectual Property: Trademarks &

Copyright
4/25 Developing Patent Research Expertise,

Pt. 3: Prior Art

Ypsilanti, MI
5/1 Developing Dialog Searching Expertise,

Pts. 1 & 2: Fast Start and Intermediate
5/1 Developing Patent Research Expertise,

Pt. 1: Patent Search Basics

Aurora, CO
5/24 What’s New/Refresher 

MidAtlantic 
Arlington, VA
4/24 Developing Dialog Searching Expertise,

Pts. 1 & 2: Fast Start and Intermediate
4/26 Developing Dialog Searching Expertise,

Pt. 3: Advanced
4/26 Developing Dialog Searching Expertise,

Pt. 4: Power Searching
5/3 Search Basics via DialogWeb
5/10 How to Find Conference Literature
5/16 Intellectual Property Update
5/22 Developing Dialog Searching Expertise,

Pts. 1 & 2: Fast Start and Intermediate
5/23 Developing Dialog Searching Expertise,

Pt. 3: Advanced
5/23 Developing Dialog Searching Expertise,

Pt. 4: Power Searching
5/31 Developing Patent Research Expertise,

Pt. 1: Patent Search Basics

Philadelphia, PA
4/24 Search Basics via DialogWeb

5/31 Developing Dialog Searching Expertise,
Pt. 3: Advanced

5/31 Developing Dialog Searching Expertise,
Pt. 4: Power Searching

New York, NY
4/25 Brown Bag: Basic Chemical Searching
4/26 Searching Dialog: The Basics
5/2 Searching Basics via DialogWeb
5/9 Brown Bag: Profound
5/15 Searching Dialog: The Basics
5/23 Search Basics via DialogWeb

South
Dallas, TX
4/25 Company Intelligence 

West
San Diego, CA
4/23 Developing Patent Research Expertise,

Pt. 1: Patent Search Basics
4/23 Developing Dialog Searching Expertise,

Pts. 1 & 2: Fast Start and Intermediate
5/14 Developing Dialog Searching Expertise,

Pts. 1 & 2: Fast Start and Intermediate
5/14 Developing Patent Research Expertise,

Pt. 1: Patent Search Basics
5/15 Developing Patent Research Expertise,

Pt. 2: Patent Families & Legal Status
5/15 Developing Patent Research Expertise,

Pt. 3: Prior Art

Los Angeles, CA
5/17 Developing Dialog Searching Expertise,

Pt. 1 & 2: Fast Start and Intermediate
5/17 Developing Patent Research Expertise,

Pt. 1: Patent Search Basics
5/18 Developing Patent Research Expertise,

Pt. 2: Patent Families & Legal Status
5/18 Developing Patent Research Expertise,

Pt. 3: Prior Art

Seattle, WA
4/26 Developing Patent Research Expertise,

Pt. 1: Patent Search Basics
5/18 Developing Dialog Searching Expertise,

Pts. 1 & 2: Fast Start and Intermediate

Continuing Education Credit (CEU) Available for Dialog Courses

Dialog is pleased to announce that Dialog
courses have just been recertified by the
International Association of Continuing
Education & Training (IACET) through
2006. 

Training Update

For more than 10 years, Dialog has
offered customers continuing education
credit when they attend Dialog training
classes. Attendance at a full-day class
earns 0.7 continuing education units
(CEU), and a half-day class 0.3 CEU.

To receive credit for a class attended,
notify the instructor at the end of class
that you want CEU credit for attendance.
A certificate will be forwarded to you from
the Dialog Training office. ◆
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